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Chapter 1: Introduction 
 

 



www.WINTERBROSE.com 

5 

 

There are multiple layouts that you can use in DAZ Studio.  To find them and 
change your settings, go to Window->Workspace->Select Layout. 
 

 
This tutorial will be using the 'Hollywood Blvd' layout.  Choosing the same layout 
setting will make it much easier to follow along. 
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In DAZ Studio, there are multiple styles that you can use.  To find them and 
change your settings, go to Window->Style->Select Style. 
 

 
 
A style window will popup.  Select the 'Main Street' style, then hit 'Accept' in 
order to use the same style that we use in this tutorial. 
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Surface & Color Terms 
 
In this tutorial we'll be going over different types of ways you can adjust 
surfaces and colors of objects in DAZ Studio.  Within these adjustments, 
some terms we will be using include Diffuse, Specular, Glossiness, 
Ambient, Reflection, and Refraction.  Some of these terms may be 
unfamiliar, so let's go over what they mean in the next few sections. 
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Diffuse 
 
When light hits an object, the Diffuse color comes from the roughness of 
the object, which makes light disperse in many directions when it hits the 
surface.  This essentially gives an object its color.  Therefore when we 
make the Diffuse color of an object 'Green' (shown below), the color of the 
object itself shows as green. 
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Specular 
 
When light hits an object, the Specular color comes from when the light 
bounces back in one general direction (unlike diffuse which bounces back 
in many directions).  So when we change the Specular color of an object to 
'Red' (shown below), we see the Specular light show as Red. 
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Glossiness 
 
The Glossiness is the attribute that decides how much area the Specular 
Light will reflect off of an object.  A lower value of Glossiness will make the 
Specular Light reflect off more area.  Whereas a higher value used for 
Glossiness will make the Specular Light reflect off less area. 
 

(Glossiness: 5%) 

 
 

(Glossiness: 100%) 
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Ambient 
 
The Ambient color is the shading of an object.  Initially the Ambient color 
is black, giving the object black shading.  If we were to change the 
Ambient color to something like 'Orange', it would give all shading on that 
object an orange color.  Since all shading is now Orange, it gives it a glow-
like look. 
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Reflection 
 
The Reflection color is the color of an object's reflections on its surface.  In 
this case the below figure is being reflected off of the plane, and since the 
plane's Reflection color is Blue, anything that reflects off of it will appear 
blue. 
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Refraction 
 
The Refraction color is the color of an object as it's light passes through a 
transparent object with an index of refraction.  The index of refraction 
changes how the light moves through the transparent object, and if there is 
an index of refraction, any object that can be seen through it will be 
refracted and have a color tinted to the current Refraction color.  In this 
case, the Cube has a Refraction color of 'Blue', so when the Orange 
Sphere is shown through it, it appears Blue. 
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Chapter 2: Basic Surfaces & Colors 
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Color Dialog 
 

This is the Color Dialog box.  This will be needed a lot for this tutorial.  
Whenever you need to change the color of an attribute, you can use this to 
get the perfect color you need. 
 
First off there are 2 sections in the Color Dialog.  The left side is the Basic 
colors, and has some predefined colors that you can quickly use for your 
projects.  The right side is the hue palette which can be used to pick very 
specific colors based on the RGB, hue, saturation, and brightness of the 
color. 
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Here are the locations of the basic colors on the color dialog: 
 

 
 
 1. Red 
 2. Blue 
 3. Yellow 
 4. Orange 
 5. Green 
 6. Black 
 7. Pink 
 8. Purple 
 9. Brown 
 10. White 
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On the hue palette, the crosshair indicates the current RGB, Hue, and 
Saturation.  To the right of the hue palette is a vertical bar.  The arrow on 
that bar indicates the Value (Val) of the color. 
 

 
 
You can click on the hue palette to change the crosshair's location. 
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Moving the crosshair horizontally changes the Hue.  Putting the crosshair 
at the very right gives us a Hue of 0. 
 

 
 
Placing the crosshair at the very left gives us a Hue of 359, which means 
we have a total of 360 Hues to choose from.  Also notice when the 
crosshair is at the bottom of both sides, the Saturation (Sat) is 0.  Moving 
the crosshair vertically changes the Saturation. 
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If we move the crosshair to the top of the palette, we get a max Saturation 
of 255, which means we can have 256 Saturation values to choose from. 
 

 
 
If you click and drag the arrow on the right vertical bar, you can change the 
Value of the color.  This essentially changes it's brightness. 
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The Hue, Saturation, and Values (HSV) all determine the RGB (Red 
Green Blue) of the color.  An alternative to using the hue palette is to 
manually enter the Red, Green, and Blue values into the textboxes, or 
even manually enter the Hue, Saturation, and Value values. 
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Primitives 
 
To learn about surfaces and colors, we need an object to work on, so let's 
create a new primitive to work on. 
 
Go to: Create -> New Primitive 
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A popup menu will appear to choose which primitive you want to make, 
where you want its origin, and what its individual attributes should be. 
 

 
 
You can click the 'Type' dropdown menu to get a list of all the primitive 
shapes that you can make. 
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Go ahead and select the Sphere Type and hit 'Accept'. 
 

 
 
Your new sphere primitive will appear in the center of your scene by 
default. 
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Go to the Activity panel on the right side of your scene and select the 
'Scene' tab.  Now select your primitive from the list of objects. 
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Surfaces (Color) 
 
Now with your Sphere selected, you can head to the Activity panel on the 
left side of your scene and click the 'Surfaces (Color)' tab shown below. 
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Diffuse Color 
 
You'll notice an option to select your object to the left, in this case 'sphere'.  
Left-click on it to open up the 'Surfaces (Color)' options for your primitive. 
 

 
 
At the very top you'll see 'Diffuse Color'.  Something you'll remember from 
our discussion in Chapter 1. 
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If you left-click on 'Diffuse Color' you'll get the Color Dialog popup. 
 

 
 
You can then select a new Diffuse Color for your primitive.  Here I picked 
a shade of purple. 
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Remember that the Diffuse Color is more or less the actual color of the 
object.  So when you change the Diffuse Color you are changing the 
object’s color.  So now we have a purple Sphere. 
 

 
 
This is what the purple Diffuse Color looks like on a Plane primitive. 
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This is what the Cube primitive looks like with a purple Diffuse Color. 
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Specular Color 
 
Now that we have worked on Diffuse Color, let's start learning about  
Specular Color.  Below the Diffuse Color section, you'll see the 'Specular 
Color' option; just left-click it to open the Color Dialog. 
 

 
 
When the Color Dialog appears, select the color you want your 'Specular 
Color' to be.  I chose a shade of blue in Basic colors. 
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Now, the area where the light shines on our primitives will have a blue tint.  
For the Sphere you'll notice a small section in the middle where the light is 
shining back. 
 

 
 
However for the Plane, because it is flat, the specular color encompasses 
the entire plane when you look directly at it. 
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Similarly for the Cube the specular color shows dominant when looking 
directly at the flat surface of one of the sides. 
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Glossiness 
 
The next attribute we are going to talk about is Glossiness.  Glossiness 
changes how much of the specular light bounces off the objects surface.  It 
is much easier to see the interaction on a sphere.  Find the 'Glossiness' 
option. 
 

 
 
Let's change the Glossiness to 10.0%. 
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For our Sphere primitive, you'll notice that the Specular Color is much 
larger in area on the surface.  This is because the sphere is much 'shinier' 
thus reflects the specular light on a larger area of its surface. 
 

 
 
On a Cube or Plane, the only way to show this interaction is by noticing 
that the specular light appears more dominant when not looking directly at 
the flat surface.  The side now appears more blue, even when looking at it 
from an angle. 
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Ambient Color 
 
Now we will talk about the Ambient Color of an object.  The Ambient Color 
attribute changes the shading of an object.  Initially the shading of an object 
is Black, so you'll usually see Black shading on the edges of your objects.  
Now find the 'Ambient Color' option. 
 

 
 
Pick an Ambient Color from the Color Dialog.  I chose a yellow color from 
the Basic colors section. 
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Initially, the yellow will encompass the entire primitive.  This is because 
there is a lot of shading on one object and our 'Ambient Strength' is set at 
100.0%. 
 

 
 
Change the 'Ambient Strength' to something less, such as 30.0%. 
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Now the Sphere maintains its other attributes while having its Ambient 
Color appear yellow.  This gives our primitives a look as if they are glowing. 
 

 
 
A Plane now has yellow tint. 

 

 
 
A Cube now has it's darker sides give off a yellowish glow. 
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Reflection Color 
 
The next attribute is the Reflection of an object.  Changing the Reflection 
of an object changes the way others appear when reflecting off of the 
object.  Before changing any of these values, I'd recommend creating a 
new primitive Sphere (sphere 2) to work with. 
 

 
 
Let's pick a Basic green color, for our 'Reflection Color'. 
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Let's change our 'Reflection Strength' to 100.0% so we have the most 
distinct reflections off of our primitive sphere. 
 

 
 
Let's load in a figure to reflect off of our primitives.  Load in a figure, such 
as the Genesis figure.  You can find the Genesis figure in the Content 
Library as shown in the image below.  Just load it into the scene along with 
your primitive(s). 
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With our 'Reflection Color' for our Sphere set to Green, our figure's 
reflection appears green. 
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With a Plane primitive, we can “mirror” a green figure. 
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And similarly, also with a Cube primitive’s reflection. 
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Refraction Color 
 
The final attribute we will talk about for this Chapter is Refraction.  
Refraction is the bending of an object's light when passing through a 
transparent object.  This only happens if we have set a value for the 'Index 
of Refraction', which signifies how much it bends, 0 being none.  Let's 
make another brand new primitive Sphere (sphere 3) for testing Refraction. 
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Before messing with our Refraction attributes, let's first make our primitive 
transparent.  To do so, find the 'Opacity Strength' attribute. 
 

 
 
Then change the 'Opacity Strength' to something less than 100.0%, which 
means no transparency.  I chose 50.0%. 
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Now you'll notice the figure can be seen through our primitive. 
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Let's now change some Refraction attributes. 
 
Let's change the 'Refraction Color' to a Basic red color. 
 
Let's also max out the 'Refraction Strength' to 100%.  Note, the higher the 
Refraction Strength, the stronger the Refraction Color. 
 
And finally let's set the 'Index of Refraction' to just 0.10. 
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With our Sphere primitive, you can see the light being bent inside the 
sphere, and a refracted image of the sphere itself at the very center. 
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With the Plane primitive, the figure looks smaller once refracted through 
the transparent object. 
 

 
 

NOTE:  This is the same effect as fish in the water 
looking smaller or larger than they really are. 
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And finally, how refraction looks using the Cube primitive. 
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Chapter 3: Advanced Surfaces 
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Textures 
 
Let's talk about adding texture images to our object's surfaces. 
 
To do this, go to the 'Diffuse Color' attribute we used earlier and left-click 
on the box at the leftmost side for the dropdown menu.  Select 'Browse...' 
to search for an image to add onto your object's surface. 
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Once you pick your image, it will show up in the left box as a thumbnail. 
 

 
 
I chose the texture shown below. 
 

 
 
NOTE:  This texture image is included with this tutorial along with the 

accompanying opacity map image you will see in the next section 
(SummerLeaf-10rr.png and SummerLeaf-10trans.png). 
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You can see how the texture appears on a primitive Cube. 
 

 
 
You can also see how it appears on a Plane. 
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By default, your texture may not appear how you want it to.  This is where 
the Tiles and Offset attributes come in handy.  Look down the options 
below Refraction, to find the Horizontal/Vertical Tiles and Offset 
attributes. 
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Let's begin with changing the 'Horizontal Tiles' to 3.00. 
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You'll notice that on a primitive Cube, the image squished itself Horizontally 
and now fits completely onto one side left to right. 
 

 
 
On a Plane, the image now has 3 copies of itself Horizontally. 
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Next we'll change the 'Horizontal Offset' to 0.50. 
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Changing the Horizontal Offset to 0.50 moves the image half of its width 
horizontally.  You can see how that looks on the Cube below. 
 

 
 
Here is the effect on a primitive Plane. 
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Now we'll change the 'Vertical Tiles' to 3.00. 
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This squishes more images of the texture vertically into the same amount 
of area, but is hard to see exactly how it changed on the Cube. 
 

 
 
If we however take a look at the Plane, we can see that it squished 3 
copies of the texture vertically into the same space. 
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Lastly, we'll change the 'Vertical Offset' to 0.30. 
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After changing the Vertical Offset, we can see that the texture has moved 
itself vertically about 30% on a Cube. 
 

 
 
We can see this even clearer on the Plane. 
 

 
 
It's a good idea to mess around with all the different Tiles and Offset values 
to better learn how they work, and to better accurately move your textures 
how you need them to appear. 
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Opacity Mapping 
 
You can also use Opacity Maps on your objects.  Start a new scene and 
create a new Plane primitive. 

 

 
 
Find the 'Opacity Strength' attribute. 
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Now you can 'Browse...' for an Opacity Map using the left-box. 
 

 
 
Shown below is the Opacity mapping image I am using. 
 

 
 

NOTE:  Opacity map images are designed with black 
being totally transparent (invisible) regions 
and white being totally opaque (solid) regions. 
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The Opacity Map will be applied to your plane and become transparent in 
the black sections of the image.  You can now see the floor around the leaf 
where the plane is now transparent. 
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You can even lower the Opacity of the entire plane by changing the Opacity 
Strength from 100.0% to 50.0%. 
 

 
 
And now the plane is at 50% transparency and you can partially see the 
floor through the leaf. 
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Bump Mapping 
 
Now we are going to be working on Bump maps.  Bump maps add a 
bumpy texture onto your objects when rendered. 
 
Go ahead and start a new Scene then add a new primitive Sphere. 
 

 
 

About halfway down the 'Surfaces (Color)' tab on our sphere, you'll see 
some Bump attributes. 
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Similar to the way we added a texture to our object, click on the box on the 
left side of 'Bump Strength' then select 'Browse...' to find and open up a 
Bump Map image you want to use. 
 

 
 
The below image is the Bump Map I used for this example. 
 

 
 
NOTE:  The above image is included with this tutorial for use in this Bump 

Mapping section along with the following Displacement Mapping 
section (Example_BumpDisp.jpg). 
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Once loaded, go ahead and max out the 'Bump Strength' at 200.0%. 
 

 
 
Initially the 'Negative Bump' and the 'Positive Bump' values will be so low 
that when you render the image you can't notice the Bump Map.  We need 
to change those values to something higher so we can see the effect on 
our object.  Go ahead and change the 'Negative Bump' to -1.00 and the 
'Positive Bump' to 1.00. 
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When the Sphere is rendered, you can see the Bump Map's effect on the 
sphere's surface. 
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Below is a close up view of the rendered Sphere with applied Bump Map. 
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Displacement Mapping 
 
We'll now talk about Displacement Maps.  Create a new Scene and make 
a new sphere and look for the attribute Displacement Strength.  Click on 
the box to the left select 'Browse...' for a Displacement Map to use. 
 

 
 

I used the same image for the Displacement Map that I used for the Bump 
Map.  Once loaded, change 'Displacement Strength' to 100.0%, 
'Minimum Displacement' to 0.00 and 'Maximum Displacement' to 10.00. 
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We can render our Sphere to see the results of the Displacement Map. 
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Here is a closer look at the rendered Sphere. 
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Chapter 4: Applied Techniques 
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Utilizing Surfaces 
 
Make a new scene and load a Person into your scene.  Once again I 
chose to load in the Genesis figure. 
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It's time to use some of the stuff we have covered and apply it to making 
some interesting figures.  Let's start off with making ourselves a figure that 
looks like the Silver Surfer. 
 
First we need to get the base color for him; the default gray color seems to 
be a good choice. 
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Let's set the Glossiness to 0.0%.  This will make him shiny.  Make sure the 
Specular Color is white and change the Specular Strength to 50.0%. 
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If we Render it now, we will get a gray figure that doesn't look much like 
what we want, but we are getting closer.  There is one more thing we need 
to add. 
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Find the 'Lighting Model' attribute near the bottom. 
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We need to change this from it's current Model 'Plastic' to something more 
metallic looking and shinier.  Change it to 'Glossy (Metallic)'. 
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Now if we render our figure, we get a representation much closer to that of 
the Silver Surfer. 
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Now let's move on to our next figure, the making of a Blue Man. 
 
Let's pick a Basic Blue color. 
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Now that we have our base color, let's change the Glossiness to 75%, so 
that it's a little less shiny compared to our metallic looking Silver Surfer.  
Let's also make our 'Specular Strength' 100.0%. 
 

 
 
Lastly we'll change our 'Lighting Model' back to 'Plastic'. 
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If we Render our figure we get a decent representation of a Blue Man.  A 
little bit shiny, but not metallic yet more like rubber. 
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We are on to our last figure.  This time we are going to take a few extra 
steps while making our Green Alien. 
 
Obviously for a Green Alien, we need a base color of Green.  So for a 
Diffuse Color I used a Basic Green color. 
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Now for our Specular Color, let's give our Green Alien a yellow color 
whenever light shines off of him.  Choose a Basic Yellow color. 
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Let's change the 'Glossiness' to 50.0%. 
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Then let's change the 'Lighting Model' to 'Skin', for something different. 
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Lastly let's add a Bump map to our figure.  We'll use the same one we used 
previously in the tutorial, nothing special needed. 
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Once we load it, we can then change the 'Bump Strength' to 200.0%.  
Now change the 'Negative Bump' to -0.25 and the 'Positive Bump' to 
0.25.  Giving the Negative and Positive Bumps low values will give the 
figure a slight texture to his skin without overdoing it. 
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After Rendering, we see we have a Green Alien, that has a tint of yellow 
where the light hits him, as well as a bumpy skin. 
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Conclusion 
 
There are lots of varieties of surfaces you can create within DAZ Studio.  
Learning how to change the looks of your surfaces through textures, 
mapping, and colors is the hardest part, now all you have to do is use your 
own creativity to produce unique and interesting creations. 
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